
Altair Monarch Release Notes           Version 15.4.0
June 5 2019

ISSUE ID RESOLVED ISSUE
MONARCH CLASSIC

MOD-2637 'f' + 'i' in PDF reports sometimes recognized as latin small ligature 'fi'

MOD-3201 Rotated PDF only works with 3.0 PDF Engine

MOD-3340 Alignment of column value in PDF Import Options does not translate to Report View

MOD-3405 Summary 'All Others' values may be incorrect when using more than one 'First N' down keys.

MOD-3424 Not Possible To Push All Fields Right if the caret is in the first character position

MOD-3439 If "Prefetch files from network drive" is enabled, temporary report copies in the specified directory are not deleted after application exit

MOD-3440 Crash in Database Design if the Data Table Preview is still loading

MOD-3442 Substring Exception occurs during Export

MOD-3450 Intermittent error - Invalid object name DBO_... Under certain conditions

MOD-3456 Enable/Disable Append DOS start-of-file character

MOD-3483 Crash with Exception "Empty path name is not legal"

NEW FEATURE Support scientific notation input when converting a column from text to numeric

ENHANCEMENT Focus Table View on newly created Calculated Field After Creation

ENHANCEMENT Display theme can be controlled via registry setting

DATA PREP STUDIO

DPS-2335 Disambiguate Change Group Names On Creation

DPS-3229 Data from the Informix connector is not loaded and displayed correctly in the preview grid

DPS-4221 Performance of Prep Data table list becomes sluggish for Workspaces containing deeply nested table trees

DPS-4307 Crash encountered when scrolling the columns in ANALYZE tab under certain conditions
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ISSUE ID RESOLVED ISSUE
DPS-4362 Shrinking the Append canvas results in rendering issue

DPS-4405 Deleted tables within Google Sheets are shown ( located in Trash folder)

DPS-4406 Cannot open Google Sheet if the tablename contains more than 127 characters

DPS-4459 Login successful even if the username and password is incorrect for Amazon EMR

DPS-4483 Numeric values have a prefix "F" when saved to Knowledge Hub

DPS-4496 Cannot open Excel files using Google Sheets connector (G Suite)

DPS-4514 Complex Workspace is very slow to open

DPS-4579 No "working" indicator when retrieving Google Sheet data

DPS-4603 Conversion from text to date fails when using comma as decimal separator in PDF Table Extractor

DPS-4610 Error messages show the same message in multiple message boxes within the connector window

DPS-4618 Logging-in using the wrong user name in the Active Drirectory connector displays the list of the tables instead of an error message

DPS-4619 Superfluous  'ActiveDirectory.' in table names for the Active Directory connector

DPS-4636 Append panel does not show tooltip when dragging multiple tables which are already related to each other

DPS-4639 Knowledge Hub not respecting case sensitivity for Group By transforms when publishing a Workspace

DPS-4641 Error message shown when opening Monarch Public

DPS-4649 Adding a metadata column causes a crash if the table is in an error state

DPS-4667 Crash when deleting one staged table in Append panel and then removing the other one from the Append panel

DPS-4669 Table items shrink to zero width when the tree is deeply nested enough and the Table panel is small.

DPS-4670 Display issues with tree connector lines when scrolling nested table tree

DPS-4685 Crash when clicking on "Manage Summaries" and clicking "Edit" using a Table with an invalid definition

DPS-4687 Preparing underlying table under a Summary does not refresh available Summaries until the user switches tables

DPS-4714 Connection Failed When Connecting to a Business Objects Environment

DPS-4751 Trap and field horizontal scrolling getting out of sync with report panel

DPS-4758 Delimited text - Clicking on Edit Load Options causes a crash if the table is currently in an error state

DPS-4763 Hubspot connection encounters script errors during OAuth login

DPS-4780 Pressing the escape key in Report Design places a control character in the trap mask

DPS-4783 Vertical scroll bar in report viewer gets clipped when the window is sufficiently small
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ISSUE ID RESOLVED ISSUE
DPS-4814 Sample text doesn't scale with report while regex is active

DPS-4817 Paste in trap editor erases one too many characters

DPS-4820 Using trap character buttons to insert trap characters does not add an undo state

DPS-4821 Trap editor loses focus after click of trap character buttons

DPS-4822 Red lines on negated characters in the mask are rendered too low 

DPS-4824 Trap editor can lose focus after hitting trap character buttons

DPS-4832 Crash with error message: Specified method is not supported if viewing the table and attempting to Open in Classic Mode

DPS-4852 Group Transform dialog's error indicator is shown when there is no error and hidden when there is an error

DPS-4853 Report Verify view enabled while there are no fields defined

DPS-4892 System.AggregateException error occurs under certain conditions when using a Summary

DPS-4893 Error saving preferences  if the %LOCALAPPDATA%\Datawatch_Corporation ... folder and the user-config file within is inaccessible

DPS-4894 Difference in behavior when deleting an imported Change list

DPS-4903 The tooltip for the error box for connectors is truncated when the error is too long.

DPS-4933 Changing the user ID or password of an ODBC DSN connection after successfully connecting crashes the application

DPS-4957 Clicking "Edit in Report Design" does not work on a Report File node when done through the right click context menu

DPS-4960 Scroll synchronization breaks for the Report View when viewing the Document Options

DPS-4968 Clicking close on silent videos minimizes the main window

DPS-5001 Pinned table with numeric values have 2 decimal places when saved to Altair Knowledge Hub 

DPS-5004 Group By encounters errors on datasets >750,000 rows

DPS-5006 Red validation error around Encoding Options in Report Design when UTF-8 is set as the default encoding.

DPS-5079 Automatically handle credential aggregation for import types previously using the aliasing system

DPS-5085 Index out of bounds error using a particular file

DPS-5086 Cannot open some password protected tables from projects imported from Monarch Classic

DPS-5092 Log file reports incorrect version of Windows

NEW FEATURE JIRA, Zendesk and Box (Metadata) Connectors added
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ISSUE ID RESOLVED ISSUE
NEW FEATURE Support scientific notation input when converting a column from text to numeric

NEW FEATURE Server-side filtering for certain Connectors

ENHANCEMENT Force all columns to text for Excel sources
ENHANCEMENT Delimited Text data type detection options
ENHANCEMENT Redesigned Context Menu & Search
ENHANCEMENT Summary enhancements
ENHANCEMENT Append Helper redesign
ENHANCEMENT Performance enhancements in Table Panel and various UI areas
ENHANCEMENT Settings redesign

DEPRECATION IBM Watson Analytics export has ben removed, due to withdrawal of the product by IBM

LICENSING

LA-366 Invalid or corrupted License File error on machine with custom date format settings
LA-364 No option to change user credentials when using Knowledge Hub licensing

NEW FEATURE Support for Altair Hyperworks Units licensing
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ISSUE ID RESOLVED ISSUE
MONARCH CLASSIC (MONARCH CLASSIC & MONARCH COMPLETE)

MOD-3089 Increase Character field length to 255 so Varchar(255) is deemed a character field for V11 compatibility

MOD-3197 Cannot delete an invalid external lookup.

MOD-3204 PDF files do not open in open dialog grid sort order when using multiple selectiion

MOD-3207 Illegal Name syntax error message when trying to export to existing excel worksheet is unhelpful

MOD-3223 SdkDocInfo.ToIso8601DateTime Exception when opening PDF file created by Monarch

MOD-3237 Cannot open text files as a database (or external lookup) if blank rows exist at the start of the file

MOD-3241 Certain Negative signs are not recognized in PDF files

MOD-3297 Crash when loading a 3.4GB text report and model file

MOD-3334 Duplicate user-defined functions appear in Functions list

MOD-3342 Export fails when appending to an existing Access file and table

MOD-3346 Incorrect labels on the Offline Deactivation Page

MOD-3365 Support for ISO 19770-2 SWID tags

MOD-3366 Monarch should open data from pinned tables in DPS workspaces without testing the source connection.

MOD-3367 Strongly Linked Functions Fail To Load If External Model Is Read-Only

MOD-3369 Ability to override the value of the TEMP and TMP environment variables with the value in the Workpath registry setting

MOD-3374 Add a download to CSV function to the Table Design Field List

ENHANCEMENT Report Chunking - the ability to process very large reports in smaller chunks.

ENHANCEMENT Ability to download the contents of the Field List to CSV

ENHANCEMENT Ability to override the value of the TEMP and TMP environment variables with the value in the Workpath registry setting
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ISSUE ID RESOLVED ISSUE
DATA PREP STUDIO (MONARCH COMPLETE ONLY)

DPS-1554 Failed to load image error appearing in log file

DPS-1831 Poor performance when populating filter values

DPS-1880 Filtering Data by Range - data doesn't refresh automatically when using the Advanced Options without 'editing' the range value first

DPS-1882 Range filter type is not working as expected

DPS-1901 Maintain argument default compatibility with Monarch Classic for the STR function

DPS-1963 Syntax error encountered when searching for a non-existent table name

DPS-2136 Incorrect Amount of Columns Defined If CSV Data Structure Significantly Changes Beyond 1000 Rows

DPS-2854 Some records are not visible after refreshing table

DPS-2915 Unexpected data format after Remove Decimals operation

DPS-3317 Missing vertical scroll bar in Excel Options dialog box

DPS-3362 Disable column suffix checkbox should be disabled if multiple aggregation types are selected

DPS-3444 Export list order should reflect the sort order in Prep Data

DPS-3864 Incorrect number of decimal places may be shown when extracting data drom PDF files

DPS-3877 Report Verify does not perform "adjust all fields" consistently with Monarch Classic for floating traps

DPS-3928 Report Design leaves residual temporary files when converting a PDF.

DPS-4051 Using the arrow while in the mask editor should force everything to scroll when reaching the horizontal limit

DPS-4199 Summary-related dropdowns appear in Export Table as CSV (Named Export)

DPS-4206 Temp file created when opening Report Design (*.index.dat) is not deleted

DPS-4224 Google Big Query is displayed instead of "Google BigQuery"

DPS-4244 The query value is not saved in the Connection dialog from Load Options > Edit Table Info
DPS-4249 Segment Temp Files generated but not getting deleted when doing Join
DPS-4262 IBM Cloudant Connection dialog's size is not fixed
DPS-4269 Ok button does not disable in Splunk when editing connection
DPS-4276 Renaming columns whilst on the Analyze tab does not re-calculate which Summaries can be applied to the selected table
DPS-4288 Support for Sharepoint Online in Open Data
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ISSUE ID RESOLVED ISSUE
DPS-4289 Export fails when appending to an existing Access file and table
DPS-4292 Error encountered when selected table has no rows.
DPS-4299 Workspace crashes when trying to edit a report in Report Design
DPS-4301 Default state of blank workspace parameter preventing user from clicking OK after selecting an application runtime parameter
DPS-4302 Error encountered when selecting a specific table using DB2 connector
DPS-4303 Duplicate message in error message window for Vertica
DPS-4308 Crash when trying to load data from Public Library
DPS-4325 Crash after entering an incorrect password (5x) for a password-protected data source
DPS-4336 Export may hang on sequential retries
DPS-4345 Crash encountered when selecting a destination folder that has a problem with a Swarm connection
DPS-4348 Report Verify displays an error but the corresponding field is not highlighted.
DPS-4363 Trapping controls getting out of horizontal scrolling sync on some wide reports
DPS-4364 Report shows up blank the second time you go into report design
DPS-4365 When loading data in the query tab preview data option, the row limit is not applied.
DPS-4371 Preview Data and OK buttons are greyed out when loading Object Tables from a Salesforce data source containing high number of fields
DPS-4385 Looping validation alert when editing a Google Analytics connection with an error
DPS-4389 Missing Alt key for File >> Open Data menu option
DPS-4420 OAuth windows prompt excessively
DPS-4423 Using Alt shortcuts to access the application menu keeps it open unnecessarily after selection is made
DPS-4424 On workspace open, DPS asks for PDF password on missing file which would normally not require a password
DPS-4431 Ctrl+mouse wheel should zoom the report viewer in Report Design
DPS-4432 Clearing templates not functioning in the same way as Monarch Classic
DPS-4439 Export tree is displayed incorrectly when prep data tree has sort applied.
DPS-4440 Regex character insertion performance degrades as it grows in length
DPS-4441 Making a filter on a runtime parameter column causes the Prepare grid to go blank and causes futher errors
DPS-4442 Blank report view presented when dragging certain PRN files into the product
DPS-4447 Crash on click to append when source tables have invalid file paths

Page 3 of 4



Datawatch Monarch Release Notes           Version 15.2.0
October 1, 2018

ISSUE ID RESOLVED ISSUE
DPS-4449 Filter does not rebuild automatically when a runtime parameter value upon which the filter depends is changed
DPS-4474 Crash when typing value in template width that is greater than report width
DPS-4487 Crash when loading an XML file in a French environment
DPS-4491 Crash may occur on a second Merge Column operation

NEW FEATURE Amazon EMR Hive, Google Sheets, Google Drive and SugarCRM Connectors added
NEW FEATURE Easily jump to the change which created the selected column

ENHANCEMENT Option to Create a "New Workspace" From the Menu Dropdown
ENHANCEMENT Show field type on field list items on calculated field expression editor
ENHANCEMENT SAS Transport open filter should support both .xpt and .stx extensions
ENHANCEMENT If you have two tables selected give a context menu option to auto-stage and open the join dialog
ENHANCEMENT Save to Swarm Improvements
ENHANCEMENT Allow more width to runtime parameters dialog on workspace open
ENHANCEMENT Application or Workspace Runtime Parameter sections are now hidden on open workspace if there are no relevant items
ENHANCEMENT Filter Redesign
ENHANCEMENT Show all available timezones
ENHANCEMENT Ability to create a new library file
ENHANCEMENT Change "Remove Column" to "Delete Column" and add "Delete Columns" to the main drop down for multi-select deletion
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Datawatch Monarch Release Notes           Version 15.1.0
July 9th, 2018

ISSUE ID RESOLVED ISSUE
MONARCH CLASSIC (MONARCH CLASSIC & MONARCH COMPLETE)

MOD-2941 Legacy PDF engine not always used when opening very old models

MOD-3256 Incorrect placement of page breaks for summary Excel exports

MOD-3285 Excel Export Error - The Excel file is incompatible with this version of Monarch.

MOD-3300 Trial license expires after 15 days even when the the trial period is 30 days

MOD-3304 Silent Uninstall with Deactivation not releasing the license

MOD-3314 Object reference not set... error when going into Report Design

MOD-3323 Function Unix_Time_Number_To_Date is working incorrectly in UserDefinedFunctions.dmod

MOD-3288 Slow clipboard copy performance when pasting over 100,000 rows

ENHANCEMENT Show Template Name In Task Progress Window

ENHANCEMENT Disable the "Clearing Template" ribbon button when the selected template is a Detail

ENHANCEMENT Monarch Utility - Save to Swarm folder browse dialog using simplified version

ENHANCEMENT Clicking export links open the folder containing the exported file

DATA PREP STUDIO (MONARCH COMPLETE ONLY)

DPS-3309 Expression box could be resized to zero

DPS-3741 Positioning Discrepencies When Loading A PDF-based Model developed using Monarch Classic

DPS-3767 Default date format of the current workspace is not applied when creating a statistics table

DPS-3817 Google AdWords: Rows with empty columns do not display

DPS-3891 Entering Document Options and re-entering Report Design temporarily disables show all template hits
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ISSUE ID RESOLVED ISSUE
DPS-3892 Duplicate columns are created when using Autodefine

DPS-3894 Pivot dialog is missing 'Sort pivot columns' and 'Disable column suffix' checkboxes

DPS-3897 Mouse wheel stops scrolling the report after performing Report Verify

DPS-3901 Failure to import certain database column types

DPS-3927 Sort creates temporary files which are not deleted

DPS-3933 Using the Import button in Lookup Fields results in an orphaned temporary file

DPS-3934 Duplicates Transform creates an orphaned temporary file

DPS-3935 Crash when drag and dropping multiple change list items from one instance into another.

DPS-3936 The Excel file is incompatible with this version of Monarch Error when exporting to a file created with certain new Excel 2016 features

DPS-3953 Issues with Percentage formats when exporting to Excel

DPS-3959 Repeated auto-define leads to no traps being created

DPS-3967 Mouse wheel stops scrolling in report view after making changes in Report Verify

DPS-3981 CSV export alignment issues

DPS-3983 Alignment issues in Edit Fields panel

DPS-3990 Multiple Model nodes cause issues when uploading to Swarm

DPS-3991 Excel Export Error - The Excel file is incompatible with this version of Monarch.

DPS-4024 Horizontal scrolling of the template editor can become out of sync with the report viewer

DPS-4025 Horizontal scrolling of the template editor can become out of sync with the report viewer when using the arrow keys

DPS-4041 Crash when launching the application when using a proxy server for license authentication with invalid credentials

DPS-4050 Rectangle Selection issues in Report Viewer

DPS-4119 Un-named export doesn't open Windows Explorer

DPS-4120 Include Column Header in the Delimited Text Export window not saved to the workspace

DPS-4127 Metadata columns for Excel data sources are not saved when saving to Swarm

DPS-4166 Named export issues when making copies of workspaces

DPS-4228 Rename column behavior is inconsistent
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ISSUE ID RESOLVED ISSUE
DPS-4240 Clearing template incorrectly applied to all templates

DPS-3900 Hitmap recalculation was causing performance issues when creating templates

DPS-1969 Fields in Append Helper UI do not accommodate medium length field names

DPS-3916 Unresponsive UI whilst converting large PDF reports

DPS-4241 Clearing Template ribbon button should be disabled when the selected template is a Detail

DPS-3915 Cursor inappropriately positioned when creating a new Lookup Field

DPS-3916 Unresponsive UI whilst converting large PDF reports

NEW FEATURE Google BigQuery, Cassandra and Hubspot Connectors added

NEW FEATURE Summaries 

ENHANCEMENT Harmonized Input Encodings with Monarch Classic

ENHANCEMENT Open data redesign

ENHANCEMENT Report pages now visible before the entire report has finished loading

ENHANCEMENT Unresponsive UI whilst converting large PDF reports

ENHANCEMENT F1 invokes online help

ENHANCEMENT File/Application menu moved to the left side of the ribbon

ENHANCEMENT When pressing OK in Report Design, the Prep window is opened

ENHANCEMENT Clicking export location link in ad hoc export complete dialog opens folder rather than copying path
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ISSUE ID RESOLVED ISSUE
MONARCH CLASSIC (MONARCH CLASSIC & MONARCH COMPLETE)

MOD-2872 Str function defaults cause blank output if a numeric value is greater than 10 digits

MOD-3069 Doubleclick Not Adding Columns In Summary Add/Remove Field Dialog

MOD-3098 Copy/paste into Excel Sheet of Monarch column with "Thousands" formatting not working as expected

MOD-3100 Total Pages shows unexpected output

MOD-3105 CMD Line triggers a return keystroke in any active application

MOD-3126 Long delay when loading complex Model with a large amount of interdependencies

MOD-3128 Long delays whilst typing regular expressions

MOD-3132 PDF file displays boxes when containing certain characters

MOD-3152 Existing Conditional Formatting In XLSX Files May Be Removed When Adding Data to File Via Export

MOD-3153 PDF File unable to load if XREF table is invalid

MOD-3155 Error when attempting to perform a Split by Key value Summary export using SAS Transport (xpt) format

MOD-3161 Import Filter not working for SAS Transport (xpt) input files

MOD-3172 Floating trap created in an earlier version not properly aligned

MOD-3188 Crash when quitting Report Design using Binary Input As A Report

MOD-3205 Monarch command lines do not preserve the casing of input arguments

MOD-3239 License Server credentials are not saved in registry on Monarch first launch

MOD-3254 Lines which contain the hyphen character (0x2010) display improperly when using some fonts

ENHANCEMENT Ability to upload Models to Monarch Swarm with Monarch Utility

ENHANCEMENT Go To Column function in context menu

ENHANCEMENT Base64Decode and Base64Encode functions

Page 1 of 3



Datawatch Monarch Release Notes           Version 15.0.0
April 30th, 2018

ISSUE ID RESOLVED ISSUE

DATA PREP STUDIO (MONARCH COMPLETE ONLY)

DPS-1064 A new path is not created during an export to Angoss
DPS-2262 Unable to get leading zeros to show in data originated in a PDF
DPS-2574 Duplicated columns may be produced by overlapping fields for text and PDF report inputs
DPS-2729 Incorrect rounding of numeric columnms when using auto-define on text and PDF report inputs
DPS-2730 Changing a Numeric column to a Character from a text or PDF Report input produces blanks
DPS-2754 Calculated Field Names are not automatically trimmed for whitespace on creation
DPS-2844 Input string was not in correct format error using MongoDB on a client system with a decimal seperator other than a period
DPS-3071 Inconsistency in loading numeric data from a Monarch project to DPS
DPS-3078 Unclear export result error in Export Data Tab when exporting to Tableau Server without supplying sufficient configuration details
DPS-3080 Unclear export result error in Export Data Tab when exporting to an open Excel file
DPS-3121 Inconsistency in data when opening a Project using Excel input containing Date/Time values
DPS-3157 Google Analytics connector dialog is initially displayed in the incorrect screen position
DPS-3181 Exporting to Swarm with a user assigned to the Consumer role produces a misleading error message
DPS-3184 Inconsistency in data when opening a Project or Model with an input of purely time values
DPS-3194 Custom change view can be maximized, but not restored.
DPS-3202 Error in log when exiting
DPS-3236 The table name loaded is different from the selected Salesforce Objects Table in Salesforce Connection dialog box
DPS-3299 The Library becomes hidden if the product icon in the taskbar is pressed whilst the Library is already open
DPS-3315 Spurious lines of text containing the word "Test" appear in log files.
DPS-3396 Watson, Tableau Tde, Cognos, and Qlik exports are failing to preserve their Overwrite state on Workspace load
DPS-3410 Escape does not cancel the append helper dialog
DPS-3416 Crash when dragging an Excel file over one of the join drop zones.
DPS-3436 Filter which is on top of an append is forced to re-evaluate every time you click away from the table and click back.
DPS-3439 'Save Credentials' option on License Credentials dialog contradicts with LS server setting
DPS-3450 Export Data label is showing * even when no exports have been added
DPS-3459 Ctrl+mwheel is not working in the formula editor of the calculated fields dialog
DPS-3476 Crash right-clicking the Close button of the Select a Transform Type Window

NEW FEATURE Google Adwords, Netsuite, Sharepoint and Vertica Connectors added
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ISSUE ID RESOLVED ISSUE
NEW FEATURE JSON Export
NEW FEATURE Object Descriptions
NEW FEATURE Column View Filtering
NEW FEATURE Runtime Parameters
NEW FEATURE Lookup Calculated Fields

ENHANCEMENT Full Report Design functionality introduced to replace Report Discovery
ENHANCEMENT Enhanced Table Append functionality
ENHANCEMENT Enhanced Monarch Swarm Workspace upload
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